
 

 

Table of Contents
Pivot Animator ...........................................................................................................................................2

Overview ..............................................................................................................................................3
Getting Started .....................................................................................................................................4

Interface at a Glance .....................................................................................................................5
Positioning Figures ........................................................................................................................7
Figure Controls ............................................................................................................................10
Animation Frame Controls ...........................................................................................................12
Saving & Opening Animations ....................................................................................................15
Playing an Animation ...................................................................................................................16

Creating Figure Types .......................................................................................................................17
Edit Mode .....................................................................................................................................19
Keyboard Shortcuts .....................................................................................................................20
STK Files .....................................................................................................................................21
Window Transparency .................................................................................................................22

Onion Skins .......................................................................................................................................23
Multi-figure Selection .........................................................................................................................24
Joining Figures ..................................................................................................................................26
Backgrounds ......................................................................................................................................28
Sprites ................................................................................................................................................29
Options ...............................................................................................................................................30
Exporting an Animation .....................................................................................................................32

Animated GIF ...............................................................................................................................33
AVI Video .....................................................................................................................................36
Separate Images .........................................................................................................................38

Language Files ..................................................................................................................................40



 

 

Pivot Animator
 

Help file for Pivot animator version 4.2 (2016)
 

The user friendly stick-figure animator for Windows.
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Overview
 
Pivot Animator is designed to be a user friendly way of creating 2D stick-man animations. The basic concept is
that stick figures can be easily moved and positioned by dragging handles. An animation is made up of frames
added to the time-line, which are shown at the top of the screen. This can require more time to create a smooth
animation than it does in flash for example, because Pivot doesn't support frame tweening. This however makes
Pivot very easy to use and gives the animator full control over figure movement.
 
New stick figures can be created in the figure builder so that any object can be created and animated.
 
An animation can be exported in a number of common formats for use on web pages or for uploading to
YouTube.
 
With enough time and effort, some very advanced animations can be created with Pivot, despite its relative
simplicity.
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Getting Started
 

The basics of creating an animation in Pivot Animator.
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Interface at a Glance
 

The main Pivot Animator window showing the default figure in the frame editing area
 
 



 

 

The figure builder window. Open by clicking 'Create Figure Type' in the main windows File menu
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Positioning Figures

Pose and Movement
A stick figure consists of 'segments' (lines, circles or images) connected by pivoting joints. Click and drag the red
handle at the end of each segment with the mouse cursor to rotate it around its pivot. Click and drag the orange
'origin' handle to move the whole figure. In this way you can easily adjust the pose of a figure to any position you want
while keeping the proportions of the figure constant. When unselected, all figure handles will be displayed in blue.
A figure can be selected by clicking on it anywhere. Rotating the mouse wheel will also change the selected figure.

  Figures can also be positioned accurately by using the arrow keys to move the selected figure or
figures in 1 pixel increments. If the cursor is positioned over a red handle, then this will have the affect of rotating
the segment in 1 pixel increments instead of moving the whole figure.

Drag a red handle to rotate the segment it's at the end of and all segment attached to it

Drag the orange handle of a figure to move the whole figure

Size / Scale and Rotation



 

 

The size of a figure can be changed in two ways. You can set the scale by using the edit box in the tools panel on
the left hand side of the main window (the default will be 100%).

  You can also change the size of a figure by dragging a red handle while holding down the Alt key on the
keyboard, which can be quicker. This can also be used to rotate the whole figure. The figure will rotate and scale
around its origin point at its orange handle.

 Holding down the Alt and Ctrl keys at the same time while dragging a red handle will lock the scale
so that the figure will only rotate.

 Holding down the Alt and Shift keys at the same time while dragging a red handle will lock the rotation
so that the figure will only scale.

Drag a red handle while holding the Alt key to rotate and scale the whole figure

Segment Stretching
In some cases it may be useful to adjust the length of a single figure segment on its own.

  This can be done by holding down the Ctrl key on the keyboard while dragging a red handle. The segment
handle will then follow the cursor position without being constrained to its default length. This can be useful for
creating realistic movements for deformable or stretchy objects as well as creating the effect of 3D movements.

If Ctrl dragging a segment from a non-default length, then it will snap back to its default length when the cursor is
close enough. It won't snap to the default length if the drag is begun from the default length. If the segment is a
non-default length and you wish to position the segment close to the default length then it will require two drags of
the handle. Firstly drag the handle so that it snaps to the default length, then release the mouse and drag again
to the length you require.



 

 

Drag a red handle while holding the Ctrl key to stretch a segment
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Figure Controls
 

Buttons on the left hand side of the main window can be used to add new figures to the editing area and modify
the current selected figure or figures. A figure can be selected by clicking any of its handles. Multiple figures can
be selected by holding shift while clicking a figure or by dragging a box around the origin handle of figures.

   The selected figure can also be changed by holding down the Ctrl key while pressing the left
or right arrow keys or by using the mouse wheel. The selected figure will then step through the figures. This can be
useful if a figure has been moved outside the screen area and so cannot be clicked.

From top to bottom the figure controls include:

  Add Figure
Add a figure to the animation. If there's more than one figure type in the animation then the figure type selector
window will appear (see below).

  Delete
Delete the selected figures.

  Edit
Open the selected figure in the figure builder window.

  Centre
Move the selected figures to the centre of the animation area.

  Flip
Flip or mirror the selected figures horizontally. A vertical flip is the same as a horizontal flip followed by a 180°
rotation.

  Colour
Change the colour of the selected figures using the Windows colour selector.

  Join / Unjoin
Join the selected figure to another figure. The button is disabled if multiple figures are selected. The origin handle
of the selected figure can be joined to any other joint if it doesn't result in a closed loop of joined figures. After
clicking the button, click one of the white handles to join the figure. Select the figure again and click the button
again to unjoin them.

  Raise
Move the selected figures in front of all other figures. If the Ctrl key is held then the selected figures will be raised
by one layer only.

  Lower
Move the selected figures behind all other figures. If the Ctrl key is held then the selected figures will be lowered
by one layer only.

 Copy
Copy the selected figures to the Windows clipboard. They can then be pasted into the same into any frame or even
into a different animation. The keyboard shortcut is Ctrl+C.



 

 

 Paste
Paste the figures that were copied using the Copy button. The button will only be enabled if there are figures in the
Windows clipboard. The keyboard shortcut is Ctrl+V.

  Scale
The percentage scale change of the figure from its default size. If multiple figures are selected, then the value
shown is that of the first selected figure and all selected figures will be scaled to maintain their relative proportions.

 Opacity / Transparency
The percentage opacity / transparency of the selected figures.

  Duplicate Figures (Edit menu)
Create an exact copy of the current figures and add them to the editing area. All properties of the figures are
duplicated where possible. This does the same as copy and paste but places the new figures in a different position
so that you know they've been duplicated. The keyboard shortcut is Ctrl+D.

Figure Selector

The figure selector can be accessed by clicking the 'Add Figure' button when there is more than one figure type in
the animation. It displays images of all figure types in the animation that have been created using the figure builder
or loaded from STK files. By clicking a figure type image, a figure of that type will be added to the frame editing
area. Hover the mouse cursor over an image to read the full name of the figure type. The figure selector window is
resizable. Double click a figure and the figure selector window will close after adding the figure.

The figure selector window, showing the default figure
and sprite (image) figures.
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Animation Frame Controls
 

An animation can be created by creating a series of frames, where each frame differs slightly from the previous.

  After moving and editing your figures from their previous positions, click the 'Add Frame' button to
add it to the time-line. The underlined A means that the 'A' keyboard key can be used as a shortcut/hotkey. The
keyboard spacebar can also be used as a shortcut.

The time-line, showing a selected frame and the right-click popup menu

The time-line shows all the frames in the animation at the top of the main window. The scroll bar underneath the
frames can be used to view any part of the animation if the number of frames exceeds the width of the window. The
position of the time-line can be moved in one frame increments by clicking the arrows at either end of the time-line
or using the keyboard arrow keys when the scroll bar has focus.

The area to the left of the time-line frames shows the number of the frame being edited or added and the repeat
number.

Hovering the cursor over the Frame number text will show the time of the current selected frame in the animation
based on the current frame rate.

Repeat:
The value entered in the Repeat edit box determines how many times the frame should be repeated when played.
This can be used to create pauses in the animation without having to create identical consecutive frames.

Editing Frames

Frames in the time-line can be edited by clicking on them. The main editing area will then show the edited frame.
After editing the frame the changes can be stored by clicking the 'Add Frame' button or by selecting another frame
in the time-line to edit. If you edit a frame and do not want to keep the changes, then you can discard the changes
by clicking the same frame in the time-line that was being edited (this action cannot be undone).

  The < and > keyboard keys can be used to step the frame being edited left or right from the current
frame being edited. This is equivalent to clicking a frame to the left or right of the current frame being edited and
can therefore be combined with the Ctrl and Shift keys to select multiple frames, as described below.

Selected Frame Controls

Frames can be selected by clicking on them in the same way as editing a frame. Selected frames are displayed
with a blue border.

  Multiple frames can be selected by using the Ctrl or Shift keys in the same way as selecting
multiple files in Windows Explorer. Click a frame while holding the Ctrl key to switch the frame between selected



 

 

and unselected. Click a frame while holding the Shift key to select all frames between the clicked frame and the
previous frame clicked.

The background image or frame repeat value can be set for multiple frames by selecting the frames as described
above, setting the background or repeat value for the last frame that was clicked and then storing the changes by
clicking the 'Add Frame' button or by selecting another frame in the time-line to edit.

The three buttons to the left of the time-line frames allow you to delete or copy the selected frames or paste
previously copied frames. The delete and copy buttons will only be enabled when at least one frame is selected.

  Delete Selected Frames
Click the delete button to delete all selected frames. This action cannot be undone and so a warning message will
appear to ask if you want to delete the selected frames or cancel.

  Copy Selected Frames
Click the copy button to copy the selected frames to the Windows clipboard. The frames can then be pasted to the
end of the animation or inserted between frames in the time-line.

  Paste Copied Frames
Click the paste button to paste previously copied frames to the end of the animation. The frames can have been
copied from the current animation or from another animation. This button will only be enabled if the Windows
clipboard contains Pivot Animator frames. Frames can be pasted from an animation with different dimensions, but
if background images are used they will either be cropped or padded out. Backgrounds and figure types from the
pasted frames will be merged with those in the existing animation to avoid duplicates where possible.

Right Click Frame Controls

Right clicking any frame in the time-line displays a pop-up menu, which provides operations that will be applied
to the clicked frame.

  Insert
Click the insert button to insert a new frame in-front of the frame that was clicked. The new frame will be an exact
copy of the frame immediately before the frame that was clicked - unless the first frame was clicked, in which case
the new frame will be a copy of the clicked frame. After inserting a frame, the new inserted frame will be selected
for editing.

  Paste Insert
Click the paste insert button to paste previously copied frames immediately before the clicked frame. In all other
ways, this is the same as the 'Paste Copied Frames' button described above.

  Delete
Click the delete button to delete the clicked frame. This action cannot be undone and so a warning message will
appear to ask if you want to delete the frame or cancel.

Previewing a Frame

 + 



 

 

Sometimes it can be useful to view the current frame without handles to see what it would look like, but without
playing the animation so that you can inspect the frame carefully. This can be done by holding the Ctrl key while
clicking the play button. Stop previewing by clicking the Stop button or by clicking anywhere on the editing canvas.
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Saving & Opening Animations
 

  PIV Files
Pivot animations can be saved in the native PIV file format. In this format the animation can be opened in Pivot to
be played or edited at a later time. All the information required for the animation is contained within the PIV file,
and so the file can be emailed or uploaded to someone else with Pivot where it can be played or edited by them.
PIV files are only supported by Pivot Animator and not by video editors or YouTube.
 
Saving an animation

  After creating an animation by adding frames to the time-line, the animation can be saved by clicking 'Save
Animation As' in the File menu. The save file window will then appear to enable you to choose a name and
location for the PIV file. Click 'Save' to finish saving. After making further changes to the animation, the PIV file
can be overwritten by clicking 'Save Animation' in the File menu or by using the keyboard shortcut Ctrl+S. A '*'
symbol will be shown in the main window title when the current animation is in an unsaved state.
 
Opening an animation

  A PIV file animation can be opened by clicking 'Open Animation' in the File menu. The open file window will
then appear. Navigate to the file, select it and click 'Open'. If the animation is long or contains many backgrounds
images or sprites, then it may take several seconds to open.
An alternative method for opening a PIV file is to drag the PIV file icon onto the Pivot Animator program icon in
Windows Explorer. This will start the program and open the animation.
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Playing an Animation
 
After adding frames to the time-line, the animation can be played by clicking the Play button in the player
controls. Stop the animation by clicking the Stop button to continue editing your animation.
 
If an existing frame is being edited, by clicking on a frame in the time-line, then the animation will begin playing
from that frame instead of from the beginning.
 
When an animation is playing, you will see the animation as it will appear when exported. The figures will not
have handles and the area outside the dotted box containing the animation area will not display anything.
 

 
  Play the animation from the beginning or from the frame being edited

 
  Stop playing the animation and return to the current frame being edited. Clicking anywhere on the editing

canvas will also have the same effect.
 

  Loop the animation when playing so that it starts playing from the beginning when it reaches the end. If
unselected, the player will stop when it reaches the end of the animation and the screen will return to the current
frame being edited. When selected, the Stop button must be clicked to stop the player.
 

  Set the playing speed of the animation. The value below the scroll bar shows the frame rate in frames per
second (fps), which ranges from 7 fps (slow playing) to 33.3 fps (fast playing). When exporting an animation as
an animated Gif or AVI video, this value will be used to set the frame rate of the exported file. The value persists
after closing and reopening the program.
 
A good tip for making good animations is to make the movement of figures smooth by making small movement
between frames so that you can set the frame rate quite high. The default value is 12 fps since this results in
fairly smooth movement without requiring very small movements and a large number of frames.
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Creating Figure Types
 
A new figure can be built using the figure builder window. Click 'Create Figure Type' in the File menu to open the
figure builder window or click the Edit Figure button to edit the selected figure. Click 'New' in the figure builder to
start a new figure.
 
Figure types are built from lines or circles, called segments. There is a limit of 255 segments per figure. After
building a figure type, it can be saved as an STK file to share with others or added to the animation editing area
with a specific name - both from the file menu. It can also be added directly to the animation by clicking 'Add To
Animation' in the File menu and giving the figure a unique name, which will identify it in the figure selector. While
building a figure, actions can be undone using the undo and redo buttons in the edit menu.
 
Information about the selected segment is displayed at the bottom of the window. This includes the total number
of segments, the segment type, thickness, length, angle and whether the segment is static or dynamic (see
Remove / restore handle below).
 
The controls for building a figure are to the left of the window and are as follows:
 

  Add a circle
Add a circle segment to the figure type. After clicking the button, click any of the handles to select the joint it
should pivot on and then click anywhere to set the length and angle of the segment.
 

  Add a line
Add a line segment to the figure type. After clicking the button, click any of the handles to select the joint it should
pivot on and then click anywhere to set the length and angle of the segment.
 

  Change segment kind
Toggle the selected segment between a line and a circle. All other segment properties will remain unchanged.
 

  Change circle fill
Toggle the selected segment between the three types of circle fill. These are; solid white, clear (no fill) and solid.
The solid fill will be the same colour as the figure when changed in an animation, but the white fill will always
remain white (as it was in Pivot v2). The button is only enabled when the selected segment is a circle.
 

  Duplicate
Duplicate the selected segment. After clicking the button, click on any of the handles on the figure to select the
joint the new segment should pivot on. Holding the Ctrl key while clicking the duplicate button will mirror the
duplicated segment, or branch if the Shift key is used (see below).
 

  Change segment thickness
Change the line thickness of the selected segment by 1 pixel. Hold down the Ctrl key while clicking and the
thickness will change by 5 pixels for more rapid adjustment. I line of zero thickness will be invisible when
unselected and when used in the animation.
 

  Remove / restore handle
Make the selected segment 'static' or 'dynamic'. A static segment will not have a handle at its end point when the
figure has been added to the animation editing area. All segments are dynamic by default. A static segment will
appear grey when not selected and a greyish blue when selected. This is useful when building detailed figures to
reduce handle clutter.
 



 

 

  Set origin joint
Set the end-point of the selected segment as the origin joint. The origin joint is the point that all other segments
branches attach to and shows the orange handle for moving the figure. Changing the origin joint is particularly
useful when repositioning the handles of sprite image figures and for joining figures at a specific point.
 

  Split segment
Split the selected segment into two segments by adding a new joint at the segment centre. The resulting two
segments will have the same properties as the original segment but will be half the length.
 

   Delete segment
Delete the selected segment. If the segment has other segments attached to its end-point, then those segments
will drop down to the pivot-point of the deleted segment.
 
 
Operations on Branches
 

  +      
Holding the shift key while using most of the segment attribute buttons will change the property for the selected
segment, but also all segments connected above it (i.e. the whole branch). This is true of the Duplicate,
Thickness, Remove handle, Split and Delete controls. This can save a lot of time when editing a figure.
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Edit Mode
 

Edit Mode can be enabled and disabled from the Edit menu. A tick will appear next to the Edit Mode menu item
when enabled.
 

 
When Edit Mode is enabled, the figure joints can be repositioned by dragging the handle without effecting the
position of any other joint. The length of the segments connected to the moved joint will therefore change.
 
When Edit Mode is disabled, the figure can be moved as a normal figure - this includes the use of the Ctrl key to
change the length of a single segment and the Alt key to scale or rotate the entire figure.
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Keyboard Shortcuts
 
Keyboard shortcuts can be used to speed up the process of building a figure. The segment button shortcuts are
shown in the button mouse over hint messages and are as follows:
 

  C - add a Circle

  L - add a Line

  K - change segment Kind

  F - change circle Fill

  D - Duplicate

  Up/Down arrow keys - change segment thickness

  S - remove / restore handle (Static / dynamic)

  O - set Origin joint

  Insert key - split segment (Insert joint)

   Delete key - Delete segment
 

 keys - Adjust window transparency
 
 
Shortcuts can also be used with the Ctrl key to Undo / Redo or Save the figure type. These are also shown to the
right of their menu items.
 

  Ctrl+Z - Undo
 

  Ctrl+Y - Redo
 
      Ctrl+T - Toggle window transparency
 
      Ctrl+E - Toggle Edit Mode
 

  Ctrl+S - Save figure
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STK Files
 

 STK (Stick figure) files are the native Pivot file format for figure types. They can be stored on your computer
to be used in animations or shared with others over the internet.
 
     An STK file can be created by clicking Save As in the File menu of the figure builder. After making changes
to an STK file in the figure builder, the file can be overwritten by clicking 'Save' or by using the keyboard shortcut
Ctrl+S.
 
     An STK file can be opened directly into the animation editing area in the main Pivot window by clicking
'Load Figure Type' in the File menu.
 
A preview of the figure will be shown in the Open File window when an STK file is selected. Clicking the
magnifying glass icon above the preview will open the preview in a separate resizable window. This window
includes the version of Pivot that the STK file was made with.
 

Open STK file window, showing preview
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Window Transparency
 
The figure builder window can be made transparent or semi-transparent so that the main window is shown
underneath. This is often useful when building new figures that need to integrate with figures already in the
editing canvas. For example, it's useful when creating multi-coloured figures using the join tool or for creating
multi-figure backgrounds.
 

  The < and > keyboard keys can be used to adjust the level of window transparency. Ctrl+t can be used
to quickly turn transparency on or off.
 

Figure builder transparency. The body and legs figures are already added to the main window canvas and joined.
The head is being built with the correct scale to fit the body.
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Onion Skins
 
Onion skins show you the position of the figures in previous or subsequent frames when editing a frame. They
are only shown in the frame editor and not when playing or exporting an animation. By being able to see the
relative position of figures in neighbouring frames it makes it easy to judge the amount of movement that should
be applied to a figure to create realistic and fluid movements. In traditional hand drawn animation, this is often
done using tracing paper or light boxes.
 
Background Onion Skin
The background onion skin is similar to the onion skins in Pivot v2, except that they are in colour and semi-
transparent. They show all the figures from the previous frame only and are displayed behind all the figures in the
frame editing area, but in-front of the background image. This is so that they don't have to be redrawn every time
a figure is moved and so makes moving figures faster.
 
Selected Figure Onion Skins
The selected figure onion skins show onion skins from multiple previous frames for the selected figure only. If
multiple figures are selected then they are not shown. These onion skins are shown just behind the selected
figure and so can normally be seen even when the editing area is filled with figures. They are shown in colour
and are semi-transparent with the amount of transparency increasing the further away that frame is from the
frame being edited.
 

A selected figure and its onion skins showing its position in 4 previous frames
 
The number of selected figure onion skins can be changed from 0-9 in the options window. There is also a check-
box that enables showing onion skins of subsequent frames when editing a frame in the middle of an animation
(Show Ahead). Displaying this kind of onion skin can slow down the movement of figures in the frame editing
area, so if it becomes to slow try setting the number of onion skins to zero. The number of onion skins is set to
zero by default for this reason.
 
The selected figure onion skins work by giving each figure an ID number that associates it with the same figure
in other frames. When you add a new figure to the editing area or duplicate a figure, the new figures will be given
a new unique ID. When you add frames to the time-line, the figures keep their ID's so that the same figure has
the same ID across all the frames that it appears in. This means that if you delete and then add a figure then you
won't see these onion skins for it since it will then have a new ID.
 
After loading a Pivot v2 or v3 animation, you won't see these onion skins until you start adding new frames,
because figures will have a unique ID in all frames. This is because Pivot v2 and v3 didn't support this kind of
onion skin and so the PIV file doesn't store the figure IDs.
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Multi-figure Selection
 
Operations can be performed on multiple figures in the frame editing area. This can save a lot of time if you want
to move multiple figures by the same amount or apply the same operation to them. Selected figures are displayed
with an orange origin handle and red segment handles. Unselected figures are displayed with blue handles.
 
Selecting and Deselecting
Selecting figures works in a similar way to selecting files in Windows Explorer, with the main difference being that
at least one figure must always be selected if figures exist. Normally when clicking a figure without dragging it,
that figure will become selected and all other figures will become unselected. However, there are several ways to
select multiple figures.
 

  Holding down the Shift key while clicking any figure will change that figure between being selected and
unselected, without effecting other figures.
 

Dragging a rectangle around multiple figures by holding the mouse down anywhere where there isn't a handle will
select any figure whose origin point is within the rectangle. This will not effect any figure outside the rectangle.
Similarly, figures can be unselected by firstly dragging a rectangle around them and then dragging so that they
are no longer inside the rectangle.
 
A group of joined figures can be selected by double clicking the figure at the base of the tree. This can be useful
if there are many other figures on the editing canvas.
 
Finally, all figures in the frame can be selected by clicking 'Select All Figures' in the Edit menu or by using the
keyboard shortcut Ctrl+A.
 
Moving Multiple Figures
Once multiple figures have been selected, they can be moved around as if they are a single object. Drag any
orange origin handle to move the selected figures or use the arrow keys to move them in 1 pixel increments.
 

  Hold down the Alt key on the keyboard and drag any red handle to rotate and scale the selected figures as
if they were a single object. The figures will rotate and scale around their common centre. As with single figures,
the Ctrl and Shift keys can be used in combination with the Alt key to lock scale and rotation respectively.
 

 + Z. The Alt and Z keys used together will lock the separation of the figures so that the position of their
centres remains constant.

 + X. The Alt and X keys used together will lock the scale of figures but allow their separation.
 



 

 

Multi-figure rotation and scaling using just the Alt key.
The green dot indicates the common centre of the selected figures and does not move.

 
Multiple Figure Operations
Most of the figure control buttons work with multiple selected figures.
 

    
The delete, colour and opacity controls work on each selected figure separately. All selected figures will be
deleted or set to the chosen colour or opacity.
 

    
The centre, flip and scale controls treat the selected figures as if they were a single object. The centre button
centres the common centre of the selected figures so that they stay in the same position relative to each other.
Similarly, the flip button flips the selected figures horizontally about their common centre. The value in the scale
control shows only the scale of the first figure that was selected, but when changed all selected figures will
change such that their scale's stay fixed relative to each other.
 

  
The raise and lower buttons send all selected figures behind or in-front of the unselected figures. They will stay in
order relative to each other. If Ctrl is held then each figure will be raised or lowered by 1 figure layer.
 

The duplicate button duplicates all figures. The resulting duplicates will have the same position relative to each
other and will then be selected. If selected figures are joined using the join tool, then the duplicates will also be
joined. If a selected figure is joined to an unselected figure, then its duplicate will be unjoined.
 

  
The edit and join buttons do not work with multiple selected figures. The join button will be disabled and the edit
button will open the figure builder, but only with the first figure that was selected.
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Joining Figures
 
Pivot Animator allows you to join figures together so that figures can be positioned as if they were a single figure.
The main difference between joining figures and using multiple figure selection is that rotating a single segment
of a figure will also rotate any figures joined to that segment.
 

Joining figures to create a multi-coloured stickman that moves as a single figure
 

The figure joining feature can be used for many different reasons, such as letting a stick-man hold an object or
for creating a stick-man or other object made up of differently coloured parts, without the need for moving each
figure separately and aligning the figures between frames.
 
Figures can be joined together recursively in chains or a tree structure, but not so that they form a loop. Multiple
figures can be joined to a single handle.
 
Figures are joined together in a tree structure in a similar way to the segments in a figure. If two unjoined figures
are joined, then the one that was selected and joined is above the other in the tree structure. The one it was
joined to is not joined but has a figure joined to it and is therefore at the base of the tree.
 
Joining and Unjoining

The join button can be found in the figure controls and is enabled only when a single figure is selected. If the
figure is not currently joined then the button will display a white handle. To join the figure to another, click the
button and all the handles that the figure is allowed to join to will turn white (static segments will also be shown).
Click any of the white handles to join the figure such that its origin point joins to the clicked handle. The figure will
then move to its joined position and the handle at the join will be white to indicate that it is joined.
 
To unjoin a figure, firstly select a joined figure. The join/unjoin button will then show a red and orange pair of
handles. Click the button and the figures will no longer be joined and can then be moved independently.
 
Positioning Joined figures
Once joined, the segments of joined figures will move as if they were a single figure when rotated. A figure joined
to a rotated segment will therefore also rotate and move such that its origin is positioned at the point it's joined to.
 



 

 

  When using the Alt key to rotate and scale a figure, all figures joined to that figure, that are above it in the
tree structure, will also rotate and scale. However, the opposite is not true - if a joined figure is rotated and scaled
using the Alt key, then the figure it is joined to, which is below it in the tree, will not be scaled or rotated. If you
want to scale and rotate a whole connected group of figures, then make sure you drag a red handle in the figure
at the base of the tree structure that all other figures attach to.
 

  The scale control in the figure controls will scale only the selected figure or figures and not any figures
joined to it.
 
Moving the Figure Origin
A join can only be made between the orange origin handle of the figure being joined and a segment or origin
handle of another figure.
 

  If you wish to join figures at two segment handles (red when selected), then you must create a new figure
type by editing one of the figures in the figure builder and using the origin tool to move the origin point to a
different handle.
 
Selecting Joined Figures
Joined figures can be selected in the normal way as described on the Multi-Figure Selection section. However,
you can also double click a figure and all figures joined to it will become selected. Double click the figure at the
based of the tree to select the whole group of joined figures. This can be useful if there are many other figures on
the editing canvas.
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Backgrounds
 
Backgrounds are images that can be loaded as the background of a frame. Different frames can contain a
different background image, which means that you can create different scenes and settings within a single
animation. A background image can be created in MS Paint or other graphics software or downloaded from the
internet.
 

  A background image can be loaded into the animation by clicking 'Load background' in the File menu.
Supported image file formats are Bitmap, JPeg, GIF and PNG.
 
Background Selector
The background selector is similar to the figure selector and provides a way to set the background to one that
has already been loaded into the animation.
 
The background selector is displayed by clicking the 'Background' button in the main window when at least one
background has already been loaded.

Created with Dr.Explain
Unregistered version

http://www.drexplain.com


 

 

Sprites
 
Sprites are images that can be moved around, scaled or rotated in the same way as a figure. A sprite is actually
a type of figure segment and so lines and circles can be connected to it by editing it in the figure builder. A sprite
image can be created in MS Paint or other graphics application or downloaded from the web.
 

  A sprite can be loaded into the frame editing area by clicking 'Load Sprite Image' in the File menu. Image
formats that are supported are Bitmap, GIF and PNG.
 
Sprites are displayed with a transparent background. The transparent colour is determined from the colour of the
bottom-left pixel of the sprite image. If you don't want any transparency then simply set the bottom left pixel to
any colour that doesn't appear in the rest of the sprite image or add a vertical or horizontal line of that colour to
the left or bottom of the image.
 
Using large sprite images can cause lag when moving figures.
 
Joining Sprites

  It is possible to join sprites together using the join feature to create very realistic stick-men or other objects
that can be moved in the same way as a figure. This is demonstrated in this video.
 

 
The first step for doing this is to create your sprite images and load them into the frame editing area.
 
The second step is to reposition the handles so that the sprite joints are at the right places.

      This can be done by clicking the edit button to open the sprite in the figure builder and
adding new lines to the locations of the new joints/handles. You can then set these lines to zero thickness and set
all but one to static so that only the two new handles are seen. Then use the origin tool to move the origin point to
one of the new handles.
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Options
 

  The options window can be accessed by clicking 'Options' in the Edit menu. Any options modified in the
options window will be stored so that the values persist after closing and reopening the program.
 
Any values changed will take effect after clicking the 'OK' button. Clicking 'Cancel' will close the window without
changing any settings.
 
Click the 'Restore Defaults' button to set all values to the default settings that Pivot had when it was first run.
 

 
Animation Dimensions
Set the width and height to set the dimensions of the animation. This is indicated by the dotted lines in the frame
editing area.
 
If you have already added frames to the time-line then you will be prompted to confirm the changes after clicking
'OK'. All frames in the time-line will then change to the new dimensions and any background images will be
cropped or padded to the new dimensions.
 
If you intend to export the animation as a video, then it is advisable to set the values to a multiple of 4 to avoid
black borders in the resulting video.
 
Onion Skins
Set the number of selected figure onion skins from 0 to 9. The default value is zero since this reduces lag when
moving figures in the frame editing area.
 
Select 'Show Ahead' to show onion skins ahead of the frame being edited when editing a frame in the middle of
the animation time-line.
 
Figure Handles
Handles are the red or orange nodes used to position the figures.
 
Show Unselected
Unselect 'Show Unselected' to show only the origin handle of unselected figures. This helps to reduce handle
clutter in the frame editing area so that selecting and moving figures is easier. When selected, all handles will be
shown as blue in unselected figures.



 

 

 
This setting does not apply to joined figures because there would then be no way to select a joined figure.
Therefore all handles are shown for unselected joined figures even when the option is unselected.
 
This option can also be changed more quickly from the main animation window by using the Ctrl+H keyboard
shortcut.
 
Autosize
Choose how the size of handles is determined. When selected, handle sizes will be based on the length of their
attaching lines. This means that neighbouring handles that are close together due to short segments will be small
to prevent overlap, which can make dragging handles easier.
 
When unselected, handle sizes are large and may overlap when close together. Handles will only reduce in size
if the lines they're attached to are both short and thin. This option can be used if you find it difficult to drag small
handles.
 
Black Outline
Choose to show handles with a black outline or not. A black outline means that the handle can always be seen
even against red or orange backgrounds, but no outline may look clearer. This does not affect the size of the
handles.
 
Language
Select the language for Pivot captions and messages.
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Exporting an Animation
 

Animations can be exported in a number of formats. These include animated GIF image files for web pages, an
AVI video for adding sound or other effects in video editing software or uploading to YouTube, and as separate
images in a number of image formats.
 

  Export an animation by clicking export in the File menu and selecting a file format from the drop-down list of
file types.
 
Exporting an animation can take several minutes depending on the length of the animation, format and options
chosen. A progress bar will be displayed while exporting.
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Animated GIF
 
Animated Gif images are often used on web pages. They have a relatively small file size compared to video
formats and can be easily embedded into web pages, but don't support sound and may result in poorer quality
since they support a maximum of only 256 different colours. This restriction can be partially overcome by
choosing appropriate colour reduction and dithering methods, described below.
 
Click 'Export Animation' in the File menu, select 'Gif (*.gif)' from the drop-down list of file types, specify a file
name and click 'Save' to display the animated Gif options and save. After setting the options, click 'OK' and wait
for the progress bar to reach the end.
 
Make sure that the speed of your animation is correct when playing before Exporting the animation because the
same frame rate will be used when exporting the Gif. This can be adjusted using the scroll bar next to the Play
and Stop buttons.
 

 
Resize
The Resize option allows you to specify a percentage to resize the dimensions of the animation. 50% is set by
default since animated Gifs normally play better when small and have a smaller file size. Change the value to
100% if you want the resulting Gif to have the same dimensions as your animation.
 
Super Sample
The Super Sample option effects the quality of the resulting animated Gif by making the edges of lines and other
objects smoother. The maximum value of 4 will result in the smoothest possible result, while the minimum value
of 1 will give no smoothing, and will therefore make the figures appear as they do when playing in Pivot. The
higher the value, the longer it will take to export the animation.
Super-sampling works by drawing each frame of the animation several times bigger than the resulting animation
and then shrinking the image down to the correct size by averaging pixels. The resulting image is therefore anti-
aliased and smoother.
 
 

http://en.wikipedia.org/wiki/Animated_gif#Animated_GIF
http://en.wikipedia.org/wiki/Super_sampling
http://en.wikipedia.org/wiki/Spatial_anti-aliasing
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Advanced Options
The advanced options can be accessed by clicking the 'Advanced' button. The advanced options will
automatically be set to try to maximise the quality and minimise the file size of the animated Gif. However, you
may also like to adjust the advanced options manually, which may require some trial and error to find the best set
of options.
 
Colour Reduction
The colour reduction option specifies the number of colours and the method for reducing the number of colours in
the animated Gif. 'Quantize Optimal' gives the best possible result but also the largest file size. If your animation
contains no colour then use 'Gray-scale (256 color)' since the result matches the animation perfectly and so no
dithering is required. 'Monochrome (2 color)' results in just the colours black and white and produces the smallest
file size.
 
Dither Mode
The Dither Mode option can be used to improve the appearance of the animation when the animation contains
a large number of colours and particularly when the animation contains gradients of gradually changing colours.
Dithering is therefore often required when backgrounds or sprite images are used that are derived from photos.
The 'Nearest (no dithering)' option will result in no dithering applied to the Gif frames. The other options provide
various different algorithms for dithering. 'Stucki' is selected by default if background or sprite images are used
since it is a fast algorithm that results in clean and sharp images. Dithering always increases the file size of the
resulting Gif.
 

Netscape colour mode with no dither (98KB)         Quantize Optimal with Stucki dither (224KB)

 
Grey-scale colour mode with no dither (175KB)                Monochrome with Stucki dither (136KB)

 
 
Optimization
The optimization options help to further reduce the file size of the animated Gif file. However, they can result in
artifacts and a reduction in quality and so they are disabled by default.
 
Merge Frames - Merge pixels with the same colour between frames.

http://en.wikipedia.org/wiki/Dither#Digital_photography_and_image_processing


 

 

Colour Palette - Sort colours by usage and remove unused entries.
Crop - Crop transparent areas for each frame. This will currently have no effect since transparency is not
supported.
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AVI Video
 
AVI videos provide the best quality output as a single file and can easily be uploaded to YouTube or other any
video sharing site. AVI videos can also be edited in video editing software for adding additional effects, captions
or audio. AVI is a container format and supports many different video codecs. The AVI options enable you to save
as a large uncompressed file for optimum quality, or compress the video using any of the video codecs installed
on your computer.
 
Click 'Export Animation' in the File menu, select 'AVI Video (*.avi)' from the drop-down list of file types, specify a
file name and click 'Save' to display the AVI Video options and save. After setting the options, click 'OK' and wait
for the progress bar to reach the end.
 
Video Speed
Make sure that the speed of your animation is correct when playing before Exporting the animation because the
same frame rate will be used when exporting the video. This can be adjusted using the scroll bar next to the Play
and Stop buttons.
 

 
Resize
The Resize option allows you to specify a percentage to resize the dimensions of the animation. 50% is set
by default to reduce the file size. Change the value to 100% if you want the resulting video to have the same
dimensions as your animation.
 
Super Sample
The Super Sample option effects the quality of the resulting video by making the edges of lines and other objects
smoother. The maximum value of 4 will result in the smoothest possible result, while the minimum value of 1 will
give no smoothing, and will therefore make the figures appear as they do when playing in Pivot. The higher the
value, the longer it will take to export the animation.
Super-sampling works by drawing each frame of the animation several times bigger than the resulting animation
and then shrinking the image down to the correct size by averaging pixels. The resulting image is therefore anti-
aliased and smoother.
 
Compress
The compress option allows you to choose to compress the video using one of the video codecs installed on your
computer. If you plan to perform further editing using video editing software, then it is suggested to not compress
the video so that there is no reduction in quality. You can then compress the video afterwards using the video
editing software before uploading to YouTube, etc. Alternatively, you could install a lossless video codec such
as Lagarith. Lagarith offers the same quality as uncompressed video but with a much smaller file size and faster
decompression for playing the video. It can be downloaded and installed from the link below. After installing, it
should automatically appear in the Compressor list in the Video Compression options.
 
http://lags.leetcode.net/codec.html
 

http://en.wikipedia.org/wiki/Audio_Video_Interleave
http://www.youtube.com
http://en.wikipedia.org/wiki/Video_codec
http://en.wikipedia.org/wiki/Video_codec
http://en.wikipedia.org/wiki/Super_sampling
http://en.wikipedia.org/wiki/Spatial_anti-aliasing
http://en.wikipedia.org/wiki/Spatial_anti-aliasing
http://en.wikipedia.org/wiki/Video_codec
http://www.youtube.com
http://lags.leetcode.net/codec.html
http://lags.leetcode.net/codec.html
http://lags.leetcode.net/codec.html


 

 

If you choose to compress the video directly from Pivot, then the following window will appear after clicking 'OK'.
The options shown in the Video Compression window are specific to the codec selected.
 

 
Note: Some video codecs require that the video dimensions be a multiple of 4. If the animation dimensions are
not a multiple of 4, the video will therefore be padded out with black borders to the next multiple of 4.
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Separate Images
 
Saving as separate images will save each frame as a separate image file. This can be useful if you want to use
individual images on web pages or if you prefer to compile the images into a video or other file format using other
software. It is advisable to create a new folder to store the images in before exporting. The Image options allow
you to export three popular image formats. The resulting image file names will be given a suffix based on their
frame number in the animation. A new folder will automatically be created to store the images in.
 
Click 'Export Animation' in the File menu, select 'Separate Images' from the drop-down list of file types, specify
a file name and click 'Save' to display the Save as Images options and save. After setting the options, click 'OK'
and wait for the progress bar to reach the end.
 

 
Image Format
PNG - A compressed but lossless image format. This is the preferred format as there is no reduction in quality
but results in a relatively small file size.
JPEG - A compressed and lossy image format normally used for photos. This may be the preferred format if
photos are used for backgrounds or sprites and you want to minimise file size.
GIF - A compressed and lossy image format normally used for simple graphics, which only supports 256 colours
but results in a small file size if the animation contains few colours.
SVG - Scalable Vector Graphics format. This format is based on a description of the object rather than pixels.
The result can be scaled to any size without loss of quality. SVG files can be viewed in most web browsers or
edited in a vector graphics software such as Inkscape. The files are XML based and so can even be edited in
a text editor. This is the best format to use if designing artwork using Pivot. If background or sprite images are
included in the frames, then they will be saved in a folder and linked to from the SVG file.
 
Save Repeated Frames
If selected, the Save Repeated Frames option saves a frame multiple times as separate files if the frame's repeat
value is greater than 1. The repeat value is the value shown in the text edit box to the left of the frame time-line at
the top of the main window.
 
Quality
The JPEG quality with 100% being best quality and largest file size. This option is only enabled if JPEG is
selected as the Image Format.
 
Resize
The Resize option allows you to specify a percentage to resize the dimensions of the animation. 50% is set by
default to reduce the file size. Change the value to 100% if you want the resulting images to have the same
dimensions as your animation.
 
Super Sample

http://en.wikipedia.org/wiki/Portable_Network_Graphics
http://en.wikipedia.org/wiki/Jpeg
http://en.wikipedia.org/wiki/Gif
https://en.wikipedia.org/wiki/Scalable_Vector_Graphics
https://inkscape.org/
https://en.wikipedia.org/wiki/XML


 

 

The Super Sample option effects the quality of the resulting images by making the edges of lines and other
objects smoother. The maximum value of 4 will result in the smoothest possible result, while the minimum value
of 1 will give no smoothing, and will therefore make the figures appear as they do when playing in Pivot. The
higher the value, the longer it will take to export the animation.
Super-sampling works by drawing each frame of the animation several times bigger than the resulting animation
and then shrinking the image down to the correct size by averaging pixels. The resulting image is therefore anti-
aliased and smoother.
This option is not enabled for SVG since SVG is not pixel based and so doesn't suffer from aliasing / pixelation.
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Language Files
 
Pivot Animator supports multiple languages that determine how captions and messages are displayed within the
program.
 

  The language can be set from the options window.
 
Creating Language Files
If you are fluent in English and another language and would like to translate Pivot to that language then you can
create your own language file for Pivot. You can then send the language file to others who speak that language to
make it easier for them to use Pivot.
 
The language files can be found in a folder called 'languages' in the location that the Pivot program was installed
to. This is normally in C:\Program Files\Pivot Animator\languages.
 
Open the English.ini file and read the instructions at the top of the file. Translate all text to the right of an '=' sign
and save as a new INI file with the name of your language. Be careful when translating text with a name to the
left of the '=' ending in 'Cap' so that you do not increase the length of the text too much.
 
You can add keyboard shortcuts to buttons by adding an '&' character in-front of the letter you want to make
the shortcut. The button caption will then appear with that letter underlined in the program (e.g. 'Add &Figure'
becomes 'Add Figure'). Make sure that there are no shortcut conflicts by making sure that there are no two
buttons with the same shortcut in the same window.
 
After translating the file, test it in Pivot making sure you check all windows.
 
If you create a language file then please send it to support@pivotanimator.net so that it can be included in future
Pivot Animator releases.
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